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Chapters Ten and Eleven concentrate on the vector area of 
Photoshop. Vector tools allow for more precision in creating 
lines, shapes and precise, complex vector-based selections. As 
Photoshop is primarily a raster application, we have spent most 
of this course selecting and changing pixels. But Photoshop also 
has powerful vector tools that allow you to create objects that 
are mathematical descriptions of lines and curves. These vector 
elements print with crisper lines and curves than bitmapped 
graphics—and they do not increase your file size like stacks of 
pixel layers do; each path adds only 1-2 KB to a document. 

Drawing with the Pen tool is very different than drawing in 
traditional ways; it’s a whole new language to learn. The rewards 
of learning how to master drawing with the pen are many. In 
these notes you will see examples of effective Pen tool usage. 
Because even “advanced” Photoshop users have trouble with the 
Pen tool, we will start at the beginning for this topic.

ACE Preparation Topics

Working with vector tools
• 	 Create shape layers and paths by using the Pen and Shape 

tools.

• 	 Explain the advantages of using vector drawing tools versus 
using raster drawing tools.

• 	 Given a scenario, alter the properties of type.

• 	 Create and edit paths by using the Paths palette.	

Bitmaps & Vectors Together

Bitmaps are collections of pixels (square dots) laid out in 
a big grid called a raster. They permit the representation 
of fine detail and subtle gradations of color and tone found 
in photorealistic images. Bitmaps lose quality when resized, 
particularly when enlarged. High-resolution bitmap images 
require large files to store the tone and color of each pixel. 

Vectors are mathematical directions for drawing lines, curves, 
and shapes. Each line, curve, or shape is an object, so vector 
graphics are also called object-oriented graphics. Vector graphics 
are resolution-independent; they can be scaled larger or smaller 
without sacrificing image quality or enlarging file size. They 
typically rely on the PostScript language to do their shape magic, 
and to print.

An individual Photoshop document can have both bitmap and 
vector components. In a layered PSD document, these elements 
are independent. Bitmap components include the Background, 
standard layers, layer masks, adjustment layers, and color and 
alpha channels. Vector components include fill layers, clipping 
paths, work and saved paths, vector masks, and type layers.

Rasterization is the conversion of vector objects into 
bitmaps. Within Photoshop, when bitmap and vector layers are 
merged or an image is flattened, rasterization occurs at the 
Image Size resolution. 

•	O nly Photoshop native or PSD, Photoshop PDF, and 
Advanced TIFF files with layers will preserve their vector 
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elements without rasterization when opened in Photoshop.

•	  When vector graphics are opened in Photoshop, you choose 
the image resolution for rasterization. Once the image 
opens, it is no longer scalable.

File format Issues
These file formats can preserve vector elements when imported 
or placed into other applications.

•	 Photoshop native or PSD, Photoshop PDF, and Advanced 
TIFF files permits maximum scalability and editability of 
vector elements. These formats are good for placing into 
InDesign, but not QuarkXPress.

•	 EPS and its subsets DCS and DCS2 preserve the scalability of 
vector elements when imported or placed into page layout 
programs.

•	 Generic PDF preserves the scalability of vector elements 
if vector data is saved. Avoid layered Photoshop PDF for 
placing into page layout programs—these huge files take too 
long to print.

•	S tandard TIFF and JPEG files preserve clipping paths, but no 
other vector elements. 

These file formats convert the file into a flattened bitmap when 
saving: GIF, JPG, BMP, PNG.

Types of Paths

Paths are non-printing, on-screen vector representations of 
lines or shapes. You can use paths to:

•	 Create precise, intricate selections.

•	 Draw smooth, anti-aliased shapes and lines.

•	 Create shapes and shape layers.

•	M ake vector masks and clipping paths.

Mathematically defined, paths consist of straight line and/or 
Bezier curved segments. Each segment has a control point 
called an anchor point at either end.

Open paths are not joined at the beginning and end. The 
simplest path is an open straight 
path segment.

Closed paths are made when the last 
anchor point is in the same location as the 
beginning. This closed line path has two 
curved segments and two anchor points.

Complex paths consist of a series of 
smaller paths called subpaths. 
This crown-shaped path is one of 
the custom shapes that ships with 
Photoshop. The white areas inside 
the shape have sub-paths to define 
them. Notice the closed subpaths 
in the Path example.

Creating Paths

The Pen tools are used to draw 
paths from scratch, and to edit 
them. 

In the Toolbox, either the Pen 
tool or the Freeform Pen tool 
can draw a path. 

The Add Anchor Point, Delete Anchor Point and the Convert Point 
Tool can be used to edit paths, so these tools are also hidden 
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under the Pen tool.

The Pen tools have so many options that you can become very 
confused if you do not pay close attention to these settings.

Before starting a path, the first thing you should do is choose 
which type of path you will draw.The Pen tools let you draw 
three kinds of paths, determined by which of the three buttons 
are clicked on the left side of the options bar.

•	 Shape Layer: makes a new shape layer, or edits an existing 
one. A new layer will be created, your path will be filled with 
color with a vector mask defining the shape. Bypass this 
setting for now. 

•	 Path: makes a new work path, or adds a subpath to an 
active path. This setting is the one we will use first.

•	 Fill pixels: uses a temporary path to paint on a pixel layer 
with the path outline, and then deletes the path. Using this 
setting is akin to creating a selection and filling the selection 
with color pixels. 

The next 2 buttons in the options bar let you choose the Pen tool 
or the Freeform tool. The following 6 buttons allow you to choose 
one of the Shape tools, which we will discuss in the next chapter. 
The downward arrow at the end of this set of icons displays the 
chosen tool’s Geometry Options. In the example above, the 
Pen tool is chosen which gives you Pen Options. The Pen tool’s 
Rubber Band option provides a preview of how the curve will flow 
as you move your cursor. When this option is chosen, the Pen tool 
indicates the line or curve the next segment will take, and helps 
beginners visualize which direction to pull direction lines. 

The Auto Add/Delete check box is on by default. This allows 
you to add anchor points with the Pen tool when putting the 
cursor over a path segment and delete anchor points when 
placing the cursor over an anchor point. This option avoids using 
the Add Anchor Point and Delete Anchor Point tools. 

The last set of icons in the options bar set whether you will add 
to a path, subtract from a path and intersect or overlap path 
areas. These settings should be familiar to you from working 
with the selection tools.

Drawing Straight Line Segments
Drawing straight line paths or path 
segments is as easy as clicking with 
the mouse. Each time you click, a new 
anchor point is created and you add a 
segment to the path.

To draw a straight open path
1.	 Choose the Pen tool.

2.	C lick in the image window to set the first anchor point. 
Note the x in the pointer that indicates the start of a new 
path.

3.	C lick again to set each subsequent point.  
The Shift key constrains to 45 degree angles.

4.	S ince each path segment is recorded as a History state, 
you can use Ctrl/Command-Z or the History palette to undo 
anchor points.

5.	T o end the path, click the Pen tool in the toolbox or Ctrl/
Command click in the document window.

6.	N ote: if you don’t end an open path, 
you could add unwanted sections to 
the path, and get caught in a “web.”
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To close a path
Click the anchor point that started the path. 
Photoshop will show an “o” in the pointer when 
you are within closing range.

Drawing Curves
When you click and drag with the pen tool, 
you make a curved segment. Direction 
points and direction lines will be 
created that control which way the curve 
flows. As you click and drag you will get a 
direction line that pulls out in both directions 
from the anchor point. The arc of the curve 
will pull out to the opposite side of the direction you drag.

To draw a curved path segment
1.	 Select the Pen tool. 

2.	 Press the mouse, and drag upwards, the 
opposite direction you want the curve to 
appear. Release the mouse button. This 
creates the first anchor point (square dot), 
and its associated direction lines and points.

3.	M ove the mouse to where you want the next 
anchor point, click and drag downward. As 
you drag, the curve appears moving upwards. 
Release the mouse button when 
you have a curve you like (you can 
edit it later).

4.	M ove the cursor to the right, press 
the mouse and drag upwards. The 
curve will pull downward.

If you hold down the shift key when 

you draw a curve, your direction lines will be constrained to a 
perfect vertical, horizontal or 45 degree line.

Direction Lines
This diagram may help you understand the relationship between a 
curved path segment and its directional lines. All the anchor points 
have been selected to show all the directional lines at once.

Notice that the length of the direction lines affects how large the 
arc of the curve is. Example A has the longest direction lines and 
the largest curve. Curves with direction lines of the same length 
and pointed in similar or exact opposite ways will have symmetrical 
curves such as example A and B. Example C shows a curve with 
differing lengths of direction lines. Because the left direction line 
is pointed to the right, the left side of the curve arcs that way. In 
example D, the right direction line was initially pulled downward and 
then rotated upward, skewing the curve.

Guided exercise 10.1: 
Drawing Curves 

In this guided exercise, you will trace over a template file with 
three open paths of various different curves to gain practice at 
drawing curves and using direction lines to control the shape 
and direction of the curves.

1.	O pen curves_practice.psd. It is inside the Ch10 folder 
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inside the student_files_3 folder.

2.	C hoose the pen tool and make sure you are set 
to draw a path by clicking on the second of the 
three icons on the left side of the Options bar.

3.	 For Figure 1, all of the direction lines need to be perfect 
verticals, use the Shift key for drawing each curve. 

a.	H old down the Shift key and click on point A of Figure 1 
and drag up to match the direction lines of the diagram.

b.	H old down the Shift key and click on point B and drag 
down to match the direction lines of the diagram. 

c.	H old down the Shift key and click on point C and drag 
up to match the direction lines of the diagram.

d.	H old down the Shift key and click on point D and drag 
down to match the direction lines of the diagram.

e.	H old down the Shift key and click on point E and drag up 
to match the direction lines of the diagram.

f.	E nd the open path by clicking on the pen tool in the tool 
bar.

4.	M ove on to Figure 2, click and drag to make anchor points 
and direction lines that follow the direction of the arrows as 
you did for Figure 1. End the open path by clicking on the 
pen tool in the tool bar.

5.	M ove on to Figure 3, click and drag to make anchor points 
and direction lines that follow the direction of the arrows 
as you did for Figure 1 and Figure 2. End the open path by 
clicking on the pen tool in the tool bar.

For more practice, turn off the Arrows layer and try it again.

Combining Curves and Straight Lines 

Straight line segments can be combined with curved segments. You 
can change from a curve to a straight line or visa versa while you 
are drawing. 

While drawing with the Pen tool, to end a straight segment and 
begin a curve, Alt/Option-click on the last created point and drag 
out a direction line before releasing the Alt/Option key. To end a 
curve and begin a straight line segment, Alt/Option-click on the 
last created point to retract the second direction line so the next 
segment can be a straight line. The Option/Alt key temporarily 
changes the Pen tool to the 
Convert Point tool (covered later in 
the chapter).

This next example shows an open 
path with two similar figures, the 
first with all curve segments, the 
second combining straight lines 
with curve segments. Again, all 
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the anchor points have been selected to show all the directional 
lines at once. 

The open path starts with Point A, a curve point. Points B and C 
were added by clicking and dragging to make curve segments.

Smooth curves are connected by anchor points called smooth 
points. Points B and C are smooth points with directional lines 
flowing in opposite directions on both sides of the points, creating 
smooth curves in either direction of the points.

Sharply curved or straight path segments are connected by 
corner points. Points D, E, F and G are corner points. Point E is 
a corner point connecting two straight line segments. Points D, F, 
and G are corner points connecting straight line segments to curve 
segments. The open path was ended with a straight line at point H.

Guided exercise 10.2: 
Smooth Points and Corner 
Points 

In this guided exercise, you 
will trace over the example file 
used in the previous section 
to get the feeling of direction 
lines and changing smooth 
points to corner points and 
visa versa.

1.	O pen curves_corners.
psd. It is inside the Ch10 
folder inside the student_
files_3 folder.

2.	C hoose the pen tool and make sure you are set to 
draw a path by clicking on the second of the three 

icons on the left side of the Options bar.

3.	C lick on the A point and drag up and to the right so that the 
direction lines matches the diagram.

4.	C lick on the B point and drag up and to the left, so that both 
direction lines match the diagram.

5.	C lick on the C point and drag down and to the left, so that 
both direction lines match the diagram.

6.	C lick on the D point and drag down and to the right, so that 
the top direction line matches the diagram. You have created 
four curved segments. Now you will create a corner point to 
start a straight segment.

7.	H old down the Option/Alt key and click on point D.

8.	H old down the Shift key (for drawing a perfectly horizontal 
line) and click on point E.

9.	C lick on point F.

10.	To make a corner point and switch from a line to a curve, 
hold down the Option/Alt key, click on point F and drag up 
and to the left, so that the top direction line matches the 
diagram.

11.	Click on the G point and drag down and to the left so that 
the upper direction line matches the diagram.

12.	Now, you will create another corner point and switch back to 
a straight segment. Hold down the Option/Alt key and click 
on point G.

13.	Click on point H. End the open path by clicking on the pen 
tool in the tool bar.

Changing Directions
Sometimes you may need to change the direction of a curve. 
To do this, use the same method of pressing the Option/Alt key 
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while pulling out the direction line in a different direction. 

In the following example, a path is 
being drawn to follow the inside of 
the shape. The curve was started 
at point A by dragging up and 
slightly to the right. At point B, 
the mouse was clicked down and 
dragged up and slightly to the left. 
The path now needs to change 
direction.

If the next anchor point was made without changing direction, 
you would see the result in the second example, below. The final 
example shows the results of holding down the Option/Alt key 
and dragging the direction point down and to the right. Point C 
was added by clicking and dragging down and to the right.

Guided exercise 10.3: 
Changing Directions 

In this guided exercise, you will trace over an example file, 
making a closed path with a change of direction. Don’t 
worry about following the diagram exactly, concentrate on 
understanding how the curves and directional lines work.

1.	O pen change_direction.psd. It 
is inside the Ch10 folder inside the 
student_files_3 folder. Position the 
document at the top of the monitor 
screen.

2.	 Choose the pen tool 
and make sure you 
are set to draw a 
path by clicking on the second of 
the three icons on the left side of 
the Options bar.

3.	C lick on the A point and drag down and to the right so that 
the lower direction line matches the diagram.

4.	C lick on the B point and drag down. Before letting go of the 
mouse, hold down the Shift key to constrain the direction 
line to a true vertical line, drag further until the direction 
lines match up with the diagram, let go of the mouse and 
then let go of the Shift key. (If you hold down the Shift key 
first before clicking on the B point, the anchor point will be 
placed in a 45 or 90 degree angle from the previous point.)

5.	C lick on the C point and drag down. The bottom direction 
line will go beyond the document. That is OK. Keep dragging 
down until the upper direction line matches up with the 
diagram. If you reach the end of the monitor screen, undo 
(Command/Control Z) and move the document up as far as 
you can or change the zoom level (Command/Control minus)  
and continue drawing.

6.	H old down the Option/Alt key, click on the C point and drag 
up to match the D direction line.

7.	C lick on the E point and start to drag up, hold down the Shift 
key and drag up until the direction lines match the diagram. 
Let go of the mouse before you let go of the Shift key.
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8.	H old down the Option/Alt key, move the cursor over point A 
until a small circle appears to show you that you are closing 
the path. Click and slowly drag up to match the diagram 
for direction line F. Again, you will need to drag beyond the 
document bounds. Your natural inclination will be to drag 
down, but you need to drag up. Let go of the mouse before 
you let go of the Option/Alt key.

Tips for Drawing Curves 

•	 You can undo your latest anchor points in the path by using 
the shortcut keys, Control/Command Z to undo the last step 
and Control/Command plus Alt/Option Z to keep stepping 
backwards. You can also press the Escape key (Esc) to undo 
the last point and press it twice to delete the entire path. 

•	 The length and angle of the direction lines 
affect the curves. The rule of thumb is to 
make the length of the direction lines be 
approximately one third of the length of the 
curve if it were straightened out. 

•	 When creating a hump, place anchor points on 
either side, not in between. 

•	 While drawing a path, press Command/Ctrl to temporarily 
switch to the Direct Selection tool to edit the path as you 
create it. When you release the Command/Ctrl key, the Path 
tool returns and you can continue to add anchor points to 
your path. See more about the Direct Selection tool and 
editing a path later in this chapter.

•	 If for some reason your path becomes deselected and you 
want to continue adding to it, simply click on the last anchor 
point and you can continue to add to the path.

•	 You will have cleaner curves if you use as few anchor points 
as you can. 

Paths Take Practice
Getting comfortable drawing with the Pen tool can take quite a bit 
of practice. Practice drawing curves and mixing curved segments 
with straight segments. Getting paths to follow the shapes you 
want involves getting familiar with pulling out direction points and 
using the Option/Alt keys for changing directions.

To help you practice, complete the next two guided exercises.

Guided exercise 10.4: 
More Curves 
and Direction 
changes 

In this guided exercise, you will 
trace over a flower path that is 
made of all curves and numerous 
direction changes. Take a moment 
to grasp the concept of this example. This is a five petal flower 
shape with direction changes at the top end and bottom end of 
each petal. The entire shape is made up of just curves, so you 
will not need to create straight line segments. Some sides of the 
petals bend inwards and some bend outwards. Every point is a 
corner point.

1.	O pen flower.psd. It is inside the Ch10 folder inside the 
student_files_3 folder. Position the document at the top of 
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the monitor screen.

2.	C hoose the pen tool and make sure you are set to 
draw a path by clicking on the second of the three 
icons on the left side of the Options bar.

3.	C lick on the A point and drag to right, matching 
up the right direction line with the diagram.

4.	C lick on the B point and drag down so that the 
upper direction line matches up with the diagram.

5.	 Option/Alt-click on the B point and drag the 
second direction line up and to the right to match 

the diagram.

6.	 Click on the C point and drag 
up and to the right so that the 
lower direction line matches up with the 
diagram.

7.	 Option/Alt-click on the C point and drag the 
second direction line down and to the right to 
match the diagram.

8.	C lick on the D point and drag to the 
left and slightly down so that the right 
direction line matches the diagram.

9.	 Option/Alt-click on the D point and drag 
the second direction line to the right to 
match the diagram.

10.	Click on the E point and drag down and to 
the right, matching up the top, left direction line with the 
diagram.

11.	Option/Alt-click on 
the E point and drag 
the second direction 

line up and to the left to match the diagram.

12.	Click on the F point and drag up and to the left so that the 
lower direction line matches up with the diagram.

13.	Option/Alt-click on the F point and drag the second direction 
line down to match the diagram.

14.	Click on the G point and drag down so that 
the upper direction line matches up with the 
diagram.

15.	Option/Alt-click on the G point and drag the 
second direction line up and to the left to 
match the diagram.

16.	Click on the H point and drag up and to the 
right so that the lower direction line matches 
up with the diagram.

17.	 Option/Alt-click on the H point and drag the 
second direction line to the left to match the 
diagram.
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18.	Click on the I point and drag up and to the 
left, matching up the bottom direction line 
with the diagram.

19.	Option/Alt-click on the I point and drag the 
second direction line to the right to match the 
diagram.

20.	Click on the J point and drag down and to 
the right so that the upper, left direction line 
matches up with the diagram.

21.	Option/Alt-click on the J point and drag 
the second direction line up and to the 
left to match the diagram.

22.	Move the cursor over point A until a small 
circle appears to show you that you are 
closing the path. Hold down the Option/Alt 
key, click on the A point and slowly drag 
up to match the diagram for the bottom 
direction line. Your natural inclination 
will be to drag down, but you need to 
drag up. Let go of the mouse before 
you let go of the Option/Alt key.

If you want more practice, try this exercise again, 
but turn off the Arrows layer and try doing it without 
the notes. When you feel comfortable, try it a third 
time, turning off the Arrows and Template layers 
and turning on the Flower layer. Draw on your own 
without any guidance.

Guided exercise 10.5: 
Combining Curves and Straight 

Segments 

In this guided exercise, you 
will trace over a path of a 
chair, combining curve and 
straight segments. You will 
subtract from the path with 
a sub path to create the cut 
out area of the chair. 

In the example pictured 
here, the curve segment 
anchor points are selected 
to show the direction lines 
and the straight segment 
anchor points are not 
selected, so appear hollow.

1.	O pen chair.psd. It is 
inside the Ch10 folder 
inside the student_files_3 folder. 

2.	C hoose the pen tool and make sure you are set 
to draw a path by clicking on the second of the 
three icons on the left side of the Options bar.

3.	S tart your path in the upper left corner. Click on the A point 
and drag to right, 
matching up the 
right direction line 
with the diagram.

4.	C lick on the B 
point and drag up 
and to the right to make a smooth point.

5.	C lick on the C point and drag down and to the right to make 
another smooth point.
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6.	C lick on the D point and drag to the right. Option/Alt click on 
the D point and drag down to make a corner point.

7.	C lick on the E point and drag down and to the left. 
Option/Alt click on the E point and drag down to 
make a corner point.

8.	C lick on the F point and drag down and to the left. 
Option/Alt click on the F point and drag down and to 
the right to make a corner point.

9.	C lick on the G point and drag down a small amount to 
make a small curve.

10.	Click on the H point and drag a small amount to the 
left to create a subtle edge to the cushion. Option/Alt 
click on the H point, do not drag. The second part of 
the direction line will be deleted.

11.	Click on all the anchor points for the right leg without 
dragging to create straight line segments.

12.	Click on the I point, then Option/Alt click and drag a short 
distance to the left to create a corner point with a very 
shallow curve.

13.	Click on the J point and drag out to the left a very short 
curve. Option/Alt click on the J point, do not drag. The 
second part of the direction line will be deleted.

14.	Click on the two anchor points to make the second leg of the 
chair.

15.	Click on the K point, then Option/Alt click and drag a short 
distance to the left to create a corner point with a very 
shallow curve.

16.	Click on the L point and drag the same amount as the last 
curve to the left, then Option/Alt click on the L point to 
retract the left side of the direction line.

17.	C lick on the two anchor points to make the third leg of the 
chair.

18.	Click on the M point, then Option/Alt click and drag a short 
distance to the left to create a corner point with a very 
shallow curve.

19.	Click on the N point and drag a short distance to the left, 
then Option/Alt click on the N point to retract the left side of 
the direction line.

20.	Click on all the anchor points for the left leg without 
dragging to create straight line segments.

21.	Click on the O point and drag a small amount upwards.

22.	Click on the P point and drag to make a very small curve.

23.	Click on the Q point and drag diagonally to the right. Option/
Alt click on the Q point and drag up and slightly to the left.

24.	Click on the R point and drag up. Option/Alt click on the R 
point and drag the curve up and to the left.

25.	Move the cursor over point A until a small circle appears 
to show you that you are closing the path. Hold down 
the Option/Alt key, click and slowly drag up to match the 
diagram for the direction line. Your natural inclination will be 
to drag down, but you need to drag up. Let go of the mouse 
before you let go of the Option/Alt key.

26.	Next, you will make the sub path that 
creates a whole in the chair. In the Options 
bar, click on the Subtract from path 
area icon.

27.	 Start at the upper left 
side, click on the S point 
and pull a direction 
line down to follow the 
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bottom circular shape of the chair.

28.	Click on the T point and drag up and to the left, creating a 
direction line about the same length and opposite angle as 
the last point.

29.	Option/Alt click on the T point to retract the upper direction 
line.

30.	Click on the U point to make a straight segment.

31.	Click on the V point and drag a shallow curve to the left.

32.	Click on the W point and drag a mirror image angle of the 
last point. Option/Alt click on the W point to retract the left 
direction line.

33.	Move the cursor over point S until a small circle appears 
to show you that you are closing the path. Hold down the 
Option/Alt key, click on the S point. Let go of the mouse 
before you let go of the Option/Alt key. By just clicking and 
not dragging, you made a straight segment connected by a 
corner point to the curve segment of the S point.

WARNING: when you use the Subtract from 
path area icon, Photoshop remembers your choice. 
The next time you go to draw a path, you could end 
up subtracting from your path when you did not intend 
to. Your path may look fine, but then will not behave 
as you want when you later fill a path. It is a good idea before 
drawing with the pen tool to always check this setting and the 
Path drawing setting on the left side of the Options bar.

The Freeform Pen Tool 

The Freeform Pen tool, with its Magnetic option is easier for 
beginners to control, but they typically make many more anchor 
points than ideal. The more anchor points, the less smooth your 

curves will be, and the longer a document 
with vector elements will take to print. On 
a PostScript printer, too many total anchor 
points can cause PostScript errors, and 
prevent the document from printing at all.

The Freeform Pen tool works much like 
the Lasso tool drawing in a freeform way. When you release the 
mouse the path will be smoothed out. You can control how much 
smoothing is applied by adjusting the Curve Fit setting in the 
Options Bar under Pen Options. To draw straight line segments, 
Option/Alt click. 

The Magnetic option lets the 
Freeform Pen tool work much like 
the Magnetic Lasso tool by snapping 
to areas bordered by high contrast. 
Only choose this option if you have a 
shape with high contrast edges. You 
can click to set anchor points or let 
the tool set them for you. 

Under the Pen Options drop down 
menu in the Options Bar, Width, 
Contrast and Frequency settings help 
control the results. 

Width sets the amount of pixels under the cursor that the tool will 
look at when placing points. You can use values from 1-40 pixels. 

Contrast sets the amount of contrast that is needed for the pen 
tool to recognize an edge. Set values between 0-100. 

Frequency sets how quickly the points will be created as you 
draw the path. Set values between 5-40 with the lower number 
creating more points. 
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The Paths Palette

The Paths palette, grouped with the 
Layers and Channels palettes by default, 
lets you activate paths, duplicate paths, 
delete paths, add paths, save paths, turn 
paths into selections, stroke paths and fill 
paths. It displays thumbnail previews of 
each document path and permits paths 
to be saved, named, and manipulated.

An unsaved path, called a work path, appears in the Paths 
palette when you start using any of the pen tools. A document 
can only have one work path. You can name and save a work 
path by double-clicking and renaming it. Each named path 
becomes a document component, like an alpha channel. When 
you click on the New Path icon to the left of the Trash icon at the 
bottom of the palette, you will get a new path named Path 1, 
Path 2, etc. These paths are named paths and will be saved with 
the document.

Only one path in the Paths palette can be highlighted at a time. 
If you draw another path, it will be added to the highlighted 
path. If no path is highlighted, Photoshop will create a new 
work path and the previous work path will be discarded. For this 
reason, you will want to be careful to save your paths. Work 
paths can easily be lost.

Notice the buttons at the bottom of the Paths palette. You 
can access the same commands from the Path Palette pop-
out menu. Using the icons will bypass a dialog box giving you 
options for the command unless you hold down the Option/Alt 
key when clicking on them.

A path will not show in the document window unless it is active. 
Click on it in the Paths Palette to make it active, click in a blank 

area under the paths to deactivate it. Delete a path from the 
Paths Palette by activating it and clicking on the Trash icon or 
dragging it to the Trash.

Editing Paths

After you have drawn your path, 
you can edit it with the Path 
Selection tool and Direct 
Selection tool. These tools are the black and white arrow icons 
located above the Pen tool in the Tool Bar. 

Note: A common mistake is to try to use the Move tool to move 
a path. The Move tool is for moving layers or pixel selections; it 
will not move a path. 

Path Selection Tool
The Path Selection tool (black arrow) will select an entire 
path. Use this tool to move or transform the whole path as one 
unit. When its Show bounding Box option is checked, a selected 
path will display a bounding box to rotate or resize the path by 
clicking and moving the handles. 
You can also transform a path by 
going to Edit > Transform Path 
and choosing among Scale, Rotate, 
Skew, Distort, or Perspective. Edit 
> Free Transform Path (Control/
Command T) also works. 

Direct Selection Tool
The Direct Selection tool (white arrow), lets click on an 
anchor point, a path segment, or a direction point and reposition 
it. It works best if you begin with a path that is deselected (has 
no highlighted anchor points. You can select numerous anchor 
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points and move them at once by dragging a marquee around 
them. You can add and delete points with the Add Anchor Point 
tool and delete anchor points with the Delete Anchor Point tool, 
but as mentioned earlier, if you have Auto Add/Delete checked 
on, you can access these tools temporarily by moving your 
cursor over an anchor point to delete an anchor point or over a 
path segment to add an anchor point. 

Using the Direct Selection Tool, you can select any number 
of anchor points and transform them in the usual manner by 
going to Edit > Transform Points and choosing among Scale, 
Rotate, or Skew. Edit > Free Transform Points (Control/
Command T) also works. 

Convert Point Tool
The Convert Point tool will change smooth 
points to corner points and visa versa. 

Click on a smooth point to change it to a corner point. 

Click and drag on a corner point to change it to a smooth point. 
This tool can also manipulate direction lines.

This example shows a direction line that has been converted 
from a smooth point into a 
corner point. With the Convert 
Point tool, Direction Point A 
was clicked on and moved 
up (B). The two Direction 
Lines can now be moved 
independent of each other.

Working with an entire path
•	T o select an entire path, click the path with the Path 

Selection tool or Option/Alt-click the path with the Direct 
Selection tool. All of the anchor points become solid. 

•	M ultiple paths can be selected by pressing the Shift key.

•	 Drag the entire path to a new location, including another 
image.

•	P ress the Delete key to remove an entire selected path.

•	U se Edit > Free Transform Path or Edit > Transform 
Path to scale, rotate, flip, skew, or distort the path.

To move path segments and anchor points
1.	C hoose the Direct Selection tool or Ctrl/Command + the 

Pen tool.

2.	C lick the path to activate the entire path (can see clear 
anchor points).

3.	 Drag a path segment to move the segment and its anchor 
point(s).

4.	 Drag an anchor point to move the anchor point and the 
segment(s) attached to it.

Adding and subtracting anchor points
With the Add Anchor Point tool or with the Pen tool on an 
active path with the Auto Add/Delete Option checked, click on 
any existing segment to add an anchor point. 

Each added point will be a smooth point. When the Add Anchor 
Point tool is over an anchor point it becomes the Direct Selection 
Tool so that the anchor point can be manipulated.

With the Delete Anchor Point tool or with the Pen tool on an 
anchor point with the Auto Add/Delete Option checked, click on 
an anchor point to remove it. 

The path will reshape. When the Delete Anchor Point Tool is over 
an Anchor point it also becomes a Direct Selection Tool. You can 
also right-click or Ctrl + click an anchor point with any pen tool 
and select Delete Anchor Point from the context menu.
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Here is an excellent step by step tutorial on using the Pen 
tools. It was written for Photoshop 6/7, but the Pen tool hasn’t 
changed much since then: Basic Pen: Jay Arraich http://www.
arraich.com/ps6_tips_ppen1.htm

Guided exercise 10.6: 
Converting Points 

In this exercise, you will work with the 
same flower image you used in Guided 
Exercise 10.4 and test out converting 
points. 

1.	O pen flower_convert.psd. Just 
to make sure you are starting with 
a correct path, you will open this 
document that has the same path 
you drew earlier. The document will 
appear to be blank.

2.	O pen the Paths Palette from the 
Windows Menu. It usually lives with 
the Layers palette group.

3.	C lick on the Path 1 path to make it 
active. You will see the path appear 
in the document.

4.	C hoose the Convert Point tool 
hidden under the Pen tool in the tool 
bar. Click on the path to make the 
anchor points appear.

5.	C lick on each of the five petals’ outer 
anchor points. When you click on 
them, these corner points will lose 

their direction points. The only curved segments left will 
emanate from the inner points.

6.	N ow click on the inner points. Notice that all the segments 
get converted to straight segments.

7.	C lick on the inner points again and drag out direction lines, 
adding curves to the inner petals.

Guided exercise 10.7: 
Editing a Path 

In this exercise, you will open a file that has a layer with pixels in 
the shape of a safety pin and a path that follow the shape, but is 
not quite right. You will 
edit the path to match 
the colored layer.

1.	O pen safety_pin.
psd. It is inside 
the Ch10 folder inside the student_files_3 folder.

2.	 Open the Paths Palette from the Windows Menu. It usually 
lives with the Layers palette group.

3.	C lick on the Practice path to make it active. You will see the 
path appear in the document. You can see that it does not 
match the yellow safety pin shape. 

4.	T he path anchor points and direction lines need adjusting. 
There are two anchor points that need to be added and the 
Convert Point tool needs to be used on two anchor points. 
There are three anchor points that are not needed and can 
be deleted. The circle sub path is the only part that does not 
need editing. 
HINT: The additional points need to be added to the first sub 
path on the left side and the end of the clasp on the top side 
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of the outside shape. The points that need deleting are on 
the left side of the middle sub path that surrounds the circle 
shape.

5.	 When you have finished editing the path, click on the Final 
path in the Paths palette and it compare to your path. You 
may have came up with a different solution, but if the path 
matches the shape well, yours is correct, too. Notice the 
economy of points used in this example. Always try to draw 
a path with as few points as possible for smoother curves.

6.	S ave the file and leave it open, you will use it in the next 
exercise.	  

Painting Paths 

Paths by themselves are non-printing 
document objects. When a path is 
active, it can be stroked or filled. 
Stroke paints pixels along the 
selection perimeter. Fill paints pixels 
inside the selection perimeter. 

One way to fill or stroke a path is by clicking the appropriate 
button at the bottom of the Paths palette. Be careful—these 
buttons apply the last stroke or fill options used 
without giving a dialog box to change settings.

The Fill Path and Stroke Path dialog boxes 
accessed from the Paths palette pop-up menu 
provide much more control, and allow the 
painting of a variety of strokes. Paths can be 
stroked or filled with any of the painting tools 
that use a brush, including the Pencil, Brush, 
Eraser, dodge, Blur, etc. HINT: if you are unsure 
how the stroke will appear, paint it on its own 

layer when possible.	

To custom-stroke a path 
1.	C hoose the foreground color to become the stroke.

2.	S et all the options for the tool you will stroke with, such as 
opacity, brush size, and painting mode.

3.	A ctivate the path to stroke.

4.	C hoose Stroke Path from the Paths palette pop-up menu 
and pick the tool of your choice from the drop-down list. 

Alternately, click the Stroke button at the bottom of the 
Paths palette, which strokes with the currently active tool 
and all its settings. If an appropriate tool is not selected, it 
strokes with 
the pencil. 

5.	C lick OK to 
create the 
stroke.

Filling a path
The Fill Path dialog 
box accessed from 
the Paths palette 
pop-up menu has 
options for color, 
patterns, blending 
modes, opacity, 
feathering and 
anti-aliasing. The 
Fill button uses 
the last settings 
used in the Edit 
> Fill dialog box or otherwise the foreground color with anti-



Chapter 10: Paths and the Pen Tools	 Page 137 

aliasing. In either case, if the path is an open path, it will fill 
to an imaginary line drawn between the starting point and the 
ending point.

Guided exercise 10.8: 
Filling and Stroking a Path 

In this exercise, you will open a file that has a layer with colored 
pixels in the shape of a safety pin and a path that somewhat 
follows the shape, but needs editing. You will edit the path to 
match the colored layer.

1.	O pen safety_pin.psd (located in the Ch10 folder inside the 
student_files_3 folder) if it is not already open from the last 
exercise.

2.	O pen the Layers palette from the Windows menu.

3.	 Turn off the visibility of the Yellow Safety Pin layer. Create 
a new layer by clicking on the New Layer icon at the bottom 
of the Layers palette. 

4.	C lick on the tab for the Paths palette. Make the Practice 
path the active path by clicking on it. This path is the path 
you edited earlier. The path should appear in the document 
window.

5.	 In the tool bar, choose a color. Make sure the path does not 
have any anchor points selected. You should just see the 
line, no anchor points or direction lines. If you do see them, 
with one of the path selection tools, click away from the path 
in the document window. 

a.	C lick on the first icon at the bottom of the Paths palette, 
to fill path with the foreground color. This is the quick 
and easy way to fill a path. 

b.	 Command/Control Z to undo.

6.	N ow, you will use the Fill Path dialog box. 

a.	C lick on the pop-out menu to the Paths palette and 
choose Fill Path.

b.	 In the Fill Path dialog box, click on the drop down menu 
next to Use and choose Color. 

c.	T he Color Picker opens up, choose a color.

d.	 Set the Feather Radius to 3 pixels.

Notice all the choices you get when you use the Fill Path 
dialog box, you can choose a color, pattern, 50% gray or 
white to fill with, 
use a blending 
mode, set opacity, 
and feathering all 
at once.

e.	C lick OK.

7.	 In the tool bar, choose a color that contrasts with the color 
you used for the fill. 

a.	C lick on the second icon at the bottom of the Paths 
palette, to stroke the path with the foreground color. 
This is the quick and easy way to stroke a path. Your 
result will depend on what tool was last chosen in the 
Stroke Path dialog box and the last chosen settings for 
that tool.  

b.	 Command/Control Z to undo.

8.	C lick on the pop-out menu to the Paths palette and choose 
Stroke Path.

a.	 In the Stroke Path dialog box, set the Tool to Brush and 
click OK. You may get the same result as the last step. 
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b.	 Command/Control Z to undo.

The advantage of using the 
Stroke Path command from 
the pop-out menu is that 
you can choose what tool 
to stroke with from all the 
painting tools. But, you will 
need to make your settings 
before using the command. 
If you want to stroke with 
certain brush settings, 
choose the Brush tool (or 
other painting tool), adjust the settings as desired, and then 
use the Stroke command.

c.	 Select the Brush tool from the tool bar. 

d.	 In the Brush Preset Picker, choose a basic brush and set 
the hardness to 100% and the Master Diameter to 3 
pixels.

e.	C lick on the pop-out menu to the Paths palette and 
choose Stroke Path.

f.	 In the Stroke Path 
dialog box, set the 
Tool to Brush and 
click OK.

Once you have used the Fill Path command, so you have a layer 
of pixels, and you want to stroke with a simple line (no need to 
use brush settings), you may want to use the Stroke command 
from the Edit menu or better yet, the Stroke layer style. You will 
be stroking the layer of pixels, not the path. Using a layer style 
will allow you to make changes to the stroke easily.

Clipping Paths

Clipping paths mask images in non-
rectangular shapes for importation into 
other programs such as PageMaker, 
InDesign, Illustrator, or QuarkXPress. 
Microsoft products such as Word and 
Publisher do not support clipping paths. 
PSD, TIF, EPS, JPG, PDF, and DCS files 
all support clipping paths. An image 
clipping path does not mask image data 
within Photoshop.

To import a file into a page layout 
program that will print on a PostScript 
printer, save in EPS, DCS, or PDF. If 
your printer lacks PostScript, save in 
standard TIF format.

To add a clipping path to an image:
1.	 Create a closed path around the part of the document you 

wish to display; anything outside the path will be clipped.

2.	 If desired, create closed subpaths to exclude additional 
document parts.

3.	N ame the path; you can’t make a work path into a clipping 
path.

4.	C hoose Clipping Path from the Paths palette pop-up menu.

5.	C hoose the path you wish to define as the clipping path 
(there can only be one).

6.	 Choose File > Save As and save the document in EPS, DSC, 
PDF, or Tif format. If EPS or DCS, choose the appropriate 
EPS preview for your operating system— if you pick the 
wrong one, your image’s screen preview will not appear 
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when you place the document into your desktop publishing 
program. 

7.	R emember, the clipped area will not be hidden when the 
document is open in Photoshop; but it will when you import 
the file into another program.

Type and Paths 

You can place type along a path—type on a path, or use type to 
fill a path—type in a path.

Type on a Path
You can place type along a work path, a saved path, 
or around a shape. To do so, select the Type tool and 
position the cursor so that it changes to the Type on 

Path icon shown above. You can then enter your text, and it will 
follow the shape of the path. If you change the shape of the 
path, the type will re-flow along it.

To move the type along the path, choose either the Direct 
Selection or Path Selection tool. Position it over the type, and 
drag the type to its new location.

To flip type to the other side of a path, choose either the Direct 
Selection or Path Selection tool. Position the tool over the type, 
and drag the type across the path.

Here are a few type on a path QuickTime tutorials:

www.photoshopuser.com/photoshopcs.html

www.planetphotoshop.com/tutorials_cs.html

Type in a Path
You can place type inside a closed path or shape. If 
you change the shape of the path, the type will re-flow 

inside it. To place the type inside the path, select the Type tool 
and position it inside the path. The cursor will change to the 
Type in Path icon shown above. You may now enter your text.

Type Beyond Type Layers

Type layers can be converted to shape layers or work paths, in 
order to use the vector tools to modify their shapes. Once you 
do this, the type is no longer editable with the Type tool.

To convert type to a shape layer
1	 Activate the type layer to convert.

2	 Duplicate the layer. Be sure to convert a duplicate layer; 
editability of the original text will be lost when converted.

3	 Choose Layer > Type > Convert to Shape.

4	E dit like any other shape layer.

To create a work path from a type layer
1	 Activate the type layer to serve as a template.

2	C hoose Layer > Type > Create Work Path.

3	 Use like any other path.

Type can also be rasterized to convert from vector text to 
editable pixels.

To rasterize a type layer
1	A ctivate the type layer to rasterize.

2	 Duplicate the layer. Editability of the original text will be lost 
when converted.

3	 Choose Layer > Rasterize > Type.

Type imported from vector programs such as Illustrator or 
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Freehand will be rasterized when brought into Photoshop CS. 
One workaround is to save the type as outlines from within the 
vector programs, then import as paths into Photoshop. You can 
then use the path-related tools to modify these paths.

Another workaround is to use SmartObjects, which we will cover 
in another course.

Guided Activity: 
Working with Paths

In this guided activity, you will open an 
image of a birdbath, draw a path around 
the birdbath, create a selection and mask 
out the background of the image. This 
image shows the type of image that 
benefits from using the path tools. The 
object to isolate has very similar colors and 
tones with the background, making it difficult to select with the 
selection tools and commands. The edges of the object are crisp 
and so would look natural with the crisp edges that paths create.

1.	O pen birdbath.psd. It is inside the Ch10 folder inside the 
student_files_3 folder.

2.	O pen the Paths palette from the Windows menu.

3.	 Select the Pen tool from the tool bar.

4.	S tart drawing a path from the top of the post where it 
connects to the bowl.

5.	A s you follow around the outside of the birdbath, keep the 
following in mind:

a.	 Try to use an economy of anchor points. 

b.	 Use the Option/Alt key to change direction where 

needed. 

c.	 Use the Command/Control key to temporarily use the 
Direct Selection tool to edit the path as you are drawing 
it. You can click on an anchor point, direction point, or 
path segment to edit.

d.	 You can edit the path after you have drawn it, to refine 
and correct it.

e.	T he scallop-like curves around the bowl are a good 
challenge. Each scallop is a gentle curve, so creating 
change of directions at each inner curve is not the best. 

Try this approach, place an anchor point on either side 
of the inner and outer curves. Drawing a curve will 
create 2 direction lines of equal length. You will need 
to lessen or lengthen one of the direction lines at each 
point. The short ends will face the inner scallop (a 
shallower curve) and the longer ends will face the outer 
curve. Use the Command/Control key to do adjust the 
direction lines after drawing each point.

6.	 When you get to the starting point, move the cursor over the 
point until you see the circle, hold down the Option/Alt key 
and click on the point, let go of the mouse and then let go of 
the Option/Alt key.

7.	 Double click on the Work Path in the Paths palette to turn it 
into a saved, named path. 

8.	C lick on the third icon at the bottom of the Paths palette, 
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Load path as a selection.

9.	 From the Select Menu, choose 
Feather. In the Feather 
Selection dialog box. Set the 
Feather Radius to 1 pixel.

10.	Click on the Layers tab at the top of the palette group to 
view the Layers palette.

11.	Double-click on the Background layer to turn it into a normal 
layer. Name is as you wish, or leave it as the default Layer 0 
and click OK.

12.	Hold down the Option/Alt key and click on the Add layer 
mask icon at the bottom of the Layers palette. You have 
successfully isolated 
the object from the 
background. This layer 
can now be brought into 
another image to give it 
a new background, or it 
can be used on a white or 
colored ground to feature 
the object.

 


